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SOASYNC – The SOALIB Client

SOASYNC is the client side Graphical Application for SOALIB. By using SOASYNC, end users

may find consuming SOALIB services easy and quick. SOASYNC provides all the necessary Graphical

options to consume SOALIB services without knowledge of how SOALIB works.

Features of SOASYNC

• Sharing data among global partners. 

• backup databases over the Internet. 

• Use subset of a large database. 

• Controlled file and database sync. 

• Copy databases of different types. 

• Use Soasync as a paid data synchronization service. 

• Map database to a business partner's database with completely different database design. 

• Synchronize multi-server distributed web sites with databases and files. 



Installation

SOASYNC can be run on operating systems like Windows, MAC and Linux. Simply download the 

product from http://www.soalib.com/download.  html website and unzip the zip file into a folder 

named Soasync.

Operating System Installation

Windows
The Soasync.exe file present in the unzipped folder is used to start running 

the client version of SOASYNC.

Linux
The executable Soasync file present in the unzipped folder is used to start 

running the client.

Mac Unzip the Soasync.zip file and save it into your Desktop or the Application folder.

Android
An android version of Soasync is available from the Google Play store, which 

installs Soasync automatically.

Start SOASYNC, you will be presented with a screen similar to the following:

http://www.soalib.com/download.html
http://www.soalib.com/download.html


Here is a reference to the visible buttons and menu items in SOASYNC.

Bind to service

Use this button to bind to the service that appears on the service URL combo 

box. A already bound service may be rebound. While the service binds, the 

progress bar at the bottom left progresses.

Log into SOALIB

Log into SOALIB after a successful bind (see the progress bar at the bottom 

right. If it is filled, the service is bound). After the user logs in, this icon will be 

disabled and the logout icon will be enabled. 

Logs out of SOALIB
Log out of SOALIB if the user is already logged in. If timeout occurs, press this 

button to logout first before logging back in. 

Exit Soasync
Press this button at any time to exit SOASYNC. If there are unsaved changes, 

SOASYNC will first prompt to save changes. 

Web Browser
Opens an internal web browser. This is included as a convenience for users. 

SOASYNC also uses internal web browser to show some of it's contents.

Create/Edit 

Connection Key

Use this button to create or edit connection key. A connection key holds 

database connection information. 

Loads a database 

metadata for the 

selected connection 

key

Loads the metadata information for a connection key. The first time a 

connection is made, SOALIB makes a real connection to the database to obtain 

the metadata and saves the metadata information locally in SOALIB's cache. 

Next time this option is selected, the metadata is obtained from the cache. The 

Refresh button in the Database view refetches the metadata from the database 

again.

Deletes the selected 

entry

Deletes the selected entry. In Connection view, this permanently deletes the 

connection key.

Refresh or Reload
Refreshes or Reloads resource. This button applies to the view where it 

appears.

Create SOALIB Account

Create SOALIB account by visiting http://soalib.com (in the Account page). Simply type in 

your name, email address and the verification code. If the username (email) does not exist, then an 

account will be created and email with password of the account will be emailed to the email address 

provide.

http://soalib.com/


Bind with SOALIB

Provide the service URL http://soalib.us/soalib/  service  s in the combo box at the top left corner 

of SOASYNC. Click on the bind button (the green outlet icon). This will bind with the service and a 

login dialog will appear. Enter the username and password sent by email and click on the Login 

button. If you get error during login or you forgot your password, then go to http://soalib.com 

Password recovery page to recover the password. A successful login will display message in the 

Message tab in the bottom view. Maximize the tab to view the messages from the server. This 

message is useful as it shows the features and limitations of the user account.

http://soalib.com/
http://soalib.us/soalib/services
http://soalib.us/soalib/services
http://soalib.us/soalib/services


Change Password

Change the randomly generated password which was sent by SOALIB to something which 

can be remembered easily. Select Account  Change → Password menu item. In the change password 

dialog, enter the old password (which was used to login) and a the new password twice.

Password Recovery

If the password is forgotten, it can be recovered from http://soalib.com Account page. Go to 

the Login page in the website and click on the Forgot your password? Link. This will take you 

through the password recovery process.

http://soalib.com/


Managing Tunnel

A tunnel is required for SOALIB to connect to a firewall protected database. Tunnel forwards 

the packets to the SOALIB service bi-directionally allowing connection to the database located in a 

local network inside a firewall. A SOALIB user may create only one tunnel for the username and 

service URL and only one tunnel may be ran in a PC. It is only necessary to create one tunnel per user

and service URL. Tunnel is required in the following situations:

• The database is not accessible outside of the firewall

• The database have a dynamic IP address

• The database works 



Creating Tunnel

1. Open the Tunnel dialog (Soasync  → Tunnel or press CTRL+SHIFT+T). Choose SOAP 

Forwarding Tab. Other tunnel tabs may not be used with Online SOALIB. 

2. Tunnel alias is a unique ID which is generated everytime a tunnel is saved. SOALIB uses this 

unique ID to communicate with the tunnels. Each tunnel can have multiple channels. 

SOALIB manages the channels so that multiple databases could be connected at the same time

using a single tunnel. 

3. Leave Auto Trust option unchecked. The Auto Trust option is only used for a licensed SOALIB 

server hosted in a different environment other than the ONLINE SOALIB. 

4. Type a name for the tunnel and hit the Save button. The name of the tunnel should identify 

the type of tunnel with possibly host name information. For example, soap_pearl-voghaus-

com is a good name. Alpha-numeric characters and underscore and hypen are the allowed 

characters. You cannot use a period.

5. Tunnel can be deleted by selecting the tunnel and then hitting the delete button.

6. Close the tunnel dialog. At any time the tunnel may be edited by selecting the tunnel from the

Tunnel Name combo box. The selected tunnel may also be deleted by hitting the Delete 

button.



Starting Tunnel

In the Tunnel Dialog, there are two ways (three ways in Windows Operating System) to start 

the tunnel. Start Internally button will start the tunnel within Soasync. The Tunnel will stop as soon 

as Soasync is exited. This option is recommended in the following cases:

• To test a tunnel

• Perform unscheduled database synchronization (one time)

• If leaving SOASYNC running is not an issue

Note that, in the following, the internal tunnel is running as indicated in the Tunnel tab at 

the bottom of the screen. The tunnel can be stopped by pressing the Stop button and then restarted. 

The second option is to start the Tunnel externally, outside Soasync in a shell. This the 

recommended option when the tunnel would have to be executed for a long term and Soasync may 

be exited at any time without affecting the tunnel. Because the Tunnel runs inside its own shell, this 

option is the best option to use when running a sync for a long time with periodic schedule.  To stop 

the tunnel, go to the Tunnel view tab at the bottom and hit the stop button. The tunnel can also be 

stopped by traditional DOS way by pressing CTRL+C on the keyboard.  While the tunnel is running, 

if the user logs out or reboots the PC, the tunnel have to be restarted again.

Finally, in Windows, there is the third launching mode of the tunnel as a windows service. In

order to set the service, you must run the Soasync.exe by right clicking on it and choosing “Run 

as administrator” and come to the Tunnel dialog and click on the option Set as Windows Service 

check box. If the service is set, then you will see that the service is running. To start the windows 

service, simply press the button “Start Service” or go to Windows service panel and start the service 



manually. In the windows service mode of the tunnel, the service will be started automatically each 

time the windows starts. In addition, the service keep on running even the user has logged out. This 

is the preferred (for windows) method of tunneling if database have to be synced periodically 

without interruption. A running tunnel will generate tunnel.log file, which will indicate an 

active running tunnel. To check if the service is running, click on the Start menu and type in the 

Search area “services” and hit enter. Find the name “SoalibTunneler” as shown below. If a new 

version of Soasync is downloaded or Soasync service was already running, the service must first be 

stopped. 

To stop a running service, simply press the “Stop Service” button in the Tunnel dialog. The 

tunnel.log will give all the clues to the reason for a service not running or the status of the service 

like connectivity and error state. When tunnel is setup as a service, it is no longer required to run 



Soasync with administrative privilege. The service could be started or stopped using the Windows 

services (see above). Alternatively, the service may also be stopped by pressing the stop button in the 

Tunnel view.

Tunnel Script

If you are using Mac OS X or Linux, you can generate a start-tunnel.sh (start-tunnel.bat in 

Windows) by hitting the Start Externally button. When the external windows successfully starts the 

tunnel, go to the Soasync application directory to find this tunnel script. You can now run the tunnel 

by simply executing the script without needing Soasync. This script may be added in a Mac OS X or 

Linux startup script to automatically start this script when the OS boots. To stop the tunnel, go to 

Soasync's Tunnel View at the bottom and hit the Stop button of if in the command shell, press CTRL + 

C. The script file location should not be changed as it requires a few jar files and also, when the 

tunnel properties are changed, so will change the script.

Troubleshooting Tunnel

When a tunnel successfully connect to a SOALIB service, it will display dots and exclamation 

mark (something like ..!..........!.....). If this pattern is not displayed, then the Tunnel is not properly 

connected to SOALIB. In that case, first stop the tunnel and then restart. If restart does not fix the 

problem, check if the web connection or proxy is working. 

1. Open a browser and visit a search engine website (Google, Bing, Yahoo, etc.) and search 

something new to make sure that you can browse.

2. Re-open SOASYNC and bind with the service. If bind fails, this is the cause why the tunnel 

was not working. If you can browse but SOASYNC fails to bind is usually caused by firewall 



and/or proxy issue. In the rare case, SOALIB may be down.

3. One of the most common reason for Tunnel not working is when the tunnel is not attached 

in the connection key. So, open the connection key and edit it and make sure that the tunnel 

is attached and the tunnel that which is attached is running.

4. Multiple instance of SOASYNC will case tunnel to fail. Make sure that there is only one copy 

of SOASYNC running in the entire computer.

5. In Windows, make sure that the Tunnel is not running as a Windows service and also 

Externally or Internally at the same time. Tunnels will not run both Externally and Internally 

at the same time. Usually, for testing the tunnel, run the tunnel internally. Once it is working,

run using other methods. For Windows, use it as Windows Service. For Linux or Mac OS X, 

use the script.

6. If, at any time, SOASYNC is automatically updated, a running tunnel should be stopped and 

then restarted.

7. The corporate firewall must allow connection be established using 6660 – 6669 ports, which

is used by SOALIB for tunneling. The corporate firewall should open these ports to SOALIB 

servers.

8. Tunnel cannot work through a proxy in Tunnel is not supported. So, ports 6660 – 6669 and 

SOALIB server itself should not be under proxy. An exception should be provided to the 

soalib.us domain and its sub-domains in proxy setting.

9. A user can run a tunnel from a SOALIB user account only once. This means, if a Tunnel is 

already running inc Computer A, the user may install SOASYNC in Computer B and run the 

Tunnel again. In that case the tunnel in Computer A, which was properly running will fail, 

but the tunnel in Computer B will run properly. So, SOALIB tunnels runs the last running 

tunnel only. To reset the tunnel in Computer A, the user have to re-save the tunnel and the 

restart it.

Peer Tunnel

Peer Tunnel is the second tab in the Tunnel dialog. Most use will use the SOAP tunnel, 

however, the Peer Tunnel allows fast and direct connection to the database by using port forwarding.

In corporate environment, the firewall must allow connect to port forwarding ports of SOALIB 

server. Peer tunnel can have secure or insecure mode. In secure mode, the data transmitted is 

encrypted. To use this mode, select the Secured check box. All other operation is same as that for the 

SOAP tunnel. Make sure to select a peer tunnel in a connection key and that the tunnel is running. If 

using the secure mode, make sure that the client.keystore file is in the Soasync's installation 

directory.



Note. Only one type of tunnel could be ran at any time in a PC. If SOAP tunnel is 

running, then connection keys attached with SOAP tunnel specification could be 

used for connection. You cannot use connection keys with Peer tunnel specification 

with SOAP tunnel. Make sure to change the tunnel to be used with the connection 

key. It is recommended to use SOAP tunnel unless speed of sync is desired. SOAP 

tunnel is quite fast, however, for databases with a large number of rows, Peer tunnel 

will stand out.

Managing Connection

All existing connections are visible on the right view (Connection view). The Refresh button (on top 

of the Connection view) reloads the connections from the server.

1. First, create a tunnel if not already created. See Managing Tunnel to create a tunnel.

2. Click on the (Connection key) or Soasync  → Connection (CTRL+SHIFT+C) to open the 

connection dialog.

3. Enter the connection information. The name field should be an identifiable name. It is 

suggested that the name should be self descriptive about the connection. For example, in our 

example the name is given as accounts.oracle.vonhas.org, which is given to mean the 

accounts database in the oracle DBMS for the organization called vonhas. Any naming 

scheme could be taken by the user. Only alpha-numeric, underscore (_), at-the-rate sign 

(@), hypen (-), period (.) is allowed in the name.



4. The hostname must be a fully qualified database server host name or an IP address. Both IPv4

or IPv6 may be provided. The database server must be accessible locally. If the database is 

running within the firewall, which is usually the case, the Tunnel must be running and the 

Security must be defined in the Security field. If the host is globally accessible using a domain

name or a static IP address, Security selection is not required. The second blank field right 

next it is the Alias field. It is not required to put an alias to this field, but it will become useful 

if you password protect the field. This means, the user is not allowed to change the setting 

once it is password protected. When a connection is password protected, the actual host 

information will not be visible, but the user interface will display the alias only.

5. The username is the database username, which must exist in the database. Again, there is a 

second field to enter an optional username alias to be displayed when the database 

connection is password protected.

6. Resource is the database name (must exist in the database). Again, there is a second field to 

enter an optional resource alias to be displayed when the database connection is password 

protected.

7. The password is the database password for the username entered above. 

8. The Instance field is required for a number of databases. For example, Ingres can be run with

multiple instances. Typically, this field is automatically enabled or disabled based on the 



database selection. If instance is required, the instance name have to be typed here. An 

alternate instance alias may also be typed to protect connection.

9. Port number is automatically selected when the Database combo box is selected. So, in our 

example, we selected Oracle from the Database combo box, the port number automatically 

changed to 1521, which is the default port of Oracle. If an alternate port is used other than 

the default port, the alternate port may be entered after choosing the Database first. Some file

based database does not use a port number. In that case, the path name should be used.

10.Path is necessary for those databases for which there are no port numbers. For example, 

Microsoft Access, Dbase, Text and Binary files does not have port numbers. This field is 

automatically enabled or disabled based on the database selection. An optional path alias may

also be defined for protection.

11.The Grammar field is a special field which can be used to access the database by directly 

entering the database access grammar, for example, the JDBC connect string. This is an 

advanced topic explained later in this chapter. A grammar alias may be defined for 

protection.

12.If supported, the Connection Pool option may be checked to pool the connection. Its use 

depends on the selected database. Most advanced database have connection pool.

13.Selection of Expiration is optional. Enter a future date when you want the connection to 

expire. An expired connection will be automatically deleted by SOALIB. 

14.Connection timeout may also be entered if higher timeout value more than 120 seconds is 

required. Timeout value may not be less than 120 seconds. 

15.If the database is within a firewall, the security must be selected. The name of the security is 

the name of the tunnel which is presently running. For example, if a tunnel named “soalib” is 

running, you should choose “soalib” from this drop down. If you select a different security, 

then the tunnel with that name should be ran instead. The security creates the binding with 

the tunnel and the connection so that the databases within the firewall is connected through 

the tunnel and passed to the remote SOALIB. Select the first option “No Security” is security is 

not desired. Security is not necessary for globally accessible databases with static IP and well 

defined domain name and is accessible through the Internet directly. Alternatively, for 

databases which are file based and not hosted in a server does not need a security. Attach the 

tunnel which was created for the username and the service URL. Tunnels created by a 

different user or for a different service URL may not be used. 

Save the connection. The connection will appear on the Connection view on the right. 

Clicking on this connection will automatically expand the connection and show the details. The 

connection may be edited at any time (if not password protected) by selecting the connection name 

from the Name combo box. 



A selected connection may also be deleted by hitting the delete button. NOTE that deleting 

connection deletes all its associated cache in the server which was used for incremental 

synchronization. If the connection is deleted and then re-created, the database will be synchronized 

entirely for the first time (for Checksum engine), thereafter incremental mode will be used.

Password Protection on Connection

Hitting the Options button extends the dialog box. The Read and Write check boxes allow the

user to make the connection both read/write and alternatively read only or write only. If Password is 

checked, the connection may not be edited without entering a valid password. The unlock password 

may be entered in the Password field. 

Read If checked, the database can be read and SELECT statements may be 

issued and INSERT and UPDATE to the database will be blocked. If 

Write is unchecked, then this database can only act as the source 

database. It cannot be written into. If Write is checked, then the 

database can be both read and written into.

Write If checked, the database can be written to and INSERT and UPDATE 

statements may be issued. If Read is unchecked, then this database can 

only act as the target database. It cannot be used as sync target 

database.

Password If Password is checked, a password should be entered to protect the 

connection. Once protected, the connection cannot be edited without 

unlocking the connection. A password protected connection hides the 

field information and displays only their aliases. If Password is checked

but no password is entered, the connection key will be locked for ever. 

Only delete operation will delete the connection, it may never be 

edited.



After entering the protection password and hitting save button will display the connection 

information without using the true hostname, username, password, database and port information, 

but replacing them with the alias (port becomes 0). This protection prevents a third person from 

modifying the connection or viewing connection information. In a multi department, multi-

organization database, a connection may be shared in a protected mode so that the connection could 

not be modified and details are hidden.

Other Operations

There are a few buttons in the Connection View as listed below.

Load Database: Loads the database referred by the

selected connection key.

Edit Key: Brings the connection edit dialog with the

selected key information. From menu, use Soasync →

Connections, or CTRL+SHIFT+C.

Reload Keys: Reloads all the keys from the server. If any

connection information is edited or deleted

asynchronously (for example, but a different Soasync or

by code), then this operation brings the latest

connection information. 

Delete: Deletes the selected connection. A delete



operation also deletes all associated cache related to the

connection.

Getting Database Metadata

Once a connection is created and the tunnel running (if necessary), then connection could be

made to the database.

1. If the database is running within the firewall in which SOASYNC is running and is not 

globally visible, the Tunnel must be started first. If the tunnel is not already running, start the

tunnel. See Starting Tunnel section to start the tunnel.

2. Hit the “Load Database” button in the Connection View to obtain database metadata. SOALIB 

will contact the Tunnel to connect to the database. After a few seconds, the database metadata

will be loaded into the Database View. See Troubleshooting section to solve problems 

obtaining metadata.

3. If you notice the tunnel activity, it will show that SOALIB connected to the database through 

the tunnel. 

Database metadata tree appear in the left Database view. It displays the details of the data 

type and relationship information. Also note that the node of the database tree contain the database 

name followed by the connection name in square brackets.



Other Operations

Other database related operations in the Database View are as follows:

Reload Database:: Re-loads the selected database by skipping the cache. The first time the database is 

loaded is cached. Then every successive loads are loaded from the cache without reading the 

database. The reload operation physically connects to the database and loads it as it is done the first 

time. For a large database, this operation may be slow.

Remove: Removes the database tree from view. This does not physically delete the database or any 

portions of it. A remove operation also does not delete the cache. 

SQL Query Editor: Launches a SQL query editor for the selected database. (See Query Editor section 

for more details). 



HTML View: Displays the database information in HTML form, which can be printed.

PDF View: Displays the database information in PDF form.



Creating Mapper

In SOALIB, a mapper is a relationship between the source and the target databases. At sync 

time, a mapper is required to be provided. A mapper may be created manually but if the source and 

the target databases are similar, the mapping may also be generated automatically. To create a 

mapper the database metadata must first be loaded in the Database view. If you do not load the 

metadata, you will get an error message shown here.



Creating New Mapper

1. Open the database metadata for which mapping is to be created. Mapping can be done on 

the same database or two different databases.

2. Select Soasync  → Mapper (CTRL+SHIFT+M) or the button in the toolbar to open a Mapper 

dialog.

3. Choose the Source and the Target database for the connection. Because this is the first time 

the mapper is created, hit the New button. If a mapper has been previously created, then 

select the mapper from the “Mappers Name” combo box and hit Open. Alternatively, a 

mapper may be uploaded from the PC by using the browse button. In either case, the 

respective mapper will be opened or a blank mapper is opened if New pressed.

4. Drag the source database from the Database View into the mapper's source area and drag the

target database from the Database View into the mapper's target area. The mapper view will 

look like something like below.

5. Expand the Source and the Target database and drag the table or column from the Source to 

the Target which you would like to map. Mapping from Target to Source is not allowed. 

Alternatively, select the source table or column and the target table or column and click on 

the button to map the selection. Table can be mapped with a table, and column can be 

mapped to a column. During mapping, no consistency check is done. To check consistency, 

click on the Consistency button,  . 



6. If the mapper is to be used for bi-directional sync, the same mapper may be used. However, 

attention is required not to map a single source column to multiple target column or tables. 

For bi-directional sync, mapping must be one-to-one. 

7. Mapped entries appear at the bottom table. These entries may be moved up or down by using

the arrow buttons near the entries or by using the popup menu (right click on the entry).

8. Save the mapper when mapping is complete by hitting the SOALIB button, , At the prompt, 

enter a mapper name which should be descriptive enough on which database or keys or the 

kind of mapping it defines. In SOALIB mappers are independent of any databases. It is simply 

a relationship between two array of table structures. At Sync time, the consistency check is 

done to determine if the mapper (i.e., the mapping defined between the two table structures 

are valid) is consistent and valid for the two database connection keys selected during sync.

A mapper that is no longer required can be deleted from the mapper opening dialog by first 

selecting the mapper and hitting the Delete button..

Printing Mappers

Mappers may be printed by converting it to HTML or PDF. The HTML can be generated by 

hitting the preview button. The PDF report may be generated by hitting the PDF button. The mappers 



may be printed either from HTML or PDF report.

HTML View: Displays the mapping information in HTML form, which can be printed.

PDF View: Displays the mapping information in PDF form.

Sync Ordering

When the database design is upon referential integrity with foreign key and self reference, 

the user may set up their own sync ordering. If sync ordering is not provided by the user, SOALIB 

will determine the best sync ordering.  Typically, SOALIB will do a good job in order the sync, but the

user may over ride it.  The user defined sync ordering tells the mapper which tables should be synced

before the other. The user may set the manual sync order by hitting the manual ordering button, . 

This is a toggle button. If the button is in the pressed state, the manual ordering is active. With this 

state, move selected map using the four buttons: up, ,; down, ; top,  and bottom, . Save the 

mapper to save the ordering.  

Consistency Checking

Check consistency before saving by hitting the Consistency button, . Consistency check 

ensures that the mapper could be used for syncing the two databases. If consistency fails at sync time,

the database will not be synced. Inconsistent map may be save in its inconsistent state allowing a 

mapper to be mapped my multiple people or at different sessions. But, consistency checks are always 

done prior to syncing. 



Schedule

Schedules allows to control sync at user defined schedules. Open the Schedule dialog by clicking on 

menu item Soasync  → Schedule... There are three schedule option and all of which may be used to 

create the schedule at the same time. The first option is setting the date and time for the schedule to 

start. The second option is to set a delay in seconds. If there is already a date and time set, then the 

delay will simply append to the time (delaying the overall schedule). If the first option was not 

selected, then delay happens every time the schedule arrives. Third the periodic repetition the 

amount of seconds elapsed between each schedule. 

For example, in the example above, the “every-one-minute” is created by setting a user 

defined delay of 60 seconds. In the other example, we have all options checked. This tells that the 

schedule will start at the specified date and time (May 26, 2014 at 6PM) after which there will be a 

20 second delay then repeated weekly (without the initial 20 second delay). Note that the first two 

option, the date-time and the delay are only one time. 

The date-time shown is the server date-time, not the date time in the PC. When scheduling 

start at specified date time, the server time should be considered. Server time is shown in the top of 

the dialog with the number of hours and minutes in lead (positive) or lag (negative) from the user's 

time.



Sync

Syncing is one of the main task of SOASYNC. Syncing requires that you have the connection 

key setup for source and the target databases and the databases are up and running and connectable 

through SOALIB. This would require that the source and target connection keys be tested at least 

once before first sync. If the database username, passwords, port or any other information changes, 

the connection keys must have to updated for sync to be successful.

A sync operation must need a mapper. As explained above, a mapper must be there which 

defines which tables and columns have to be synced. If a mapper is not created, one must first be 

created for syncing.

If the sync have to be running on a schedule, for example, periodically or at a certain date 

and time (with or without delay), then a schedule must also be created.

To setup a sync, first connect the source and target database using the respective connection 

key. Once they are connected, they will appear on the Database view on the left. Bring up the Sync 

dialog box by clicking on Soasync  → Sync... Sync dialog have two tabs: Sync and Options. Sync tab 

defines the source and target databases, instance, mapper and schedule information. The Options tab 

defines the sync options. Select the source database key from the Source Key combo box. Similarly, 

select the target database key using the Target Key combo box. An instance name is simply an alpha-

numeric (hypen, underscore, period are allowed) name which is used to identify the running 

instance. SOALIB can instantiate multiple syncs and therefore, a good identifiable name is 

recommended. Select a schedule, if scheduling is necessary then click the Schedule check box. 

Checking the schedule check box is necessary, otherwise scheduling will be ignored. Finally select 

the mapper which was used to define the mapping between the two databases. 





Go to the Options tab and select the kind of sync to use. The options Real-Time Mode and the 

Snapshot Modes are for future use. Auto-Commit option commits whatever is partially synced even 

when the sync is not finished. Rollback On Failure overrides this option (i.e., Auto-Commit is 

ignored). In Rollback On Failure, the entire sync operation is done as a single transaction. If the sync 

does not finish, then all sync done during the transaction is rolled back. This is the preferred method 

of syncing when the database is tight on referential constraints. Retry On Failure option retries the 

sync operation one more time if sync fails the first time before giving up. This option should be 

chosen carefully as a retry operation will not necessarily lead to fixing the sync if the network or 

database failure happen. Lock Table On Sync option locks the table which is being synced to. This 

prevents other database users into writing into this table. Some times this option is useful when the 

priority of sync is more important than allowing the users to write into the database. Keep in mind 

that when sync a large table, this locking may persist for a longer time. Bidirectional Mode is one of 

the most important option as it allows bi-directional sync. In this mode, first source to target is 

synced. After successful sync, target to source is synced. Note that, in bi-directional mode, both the 

source and the target connection key should be Read/Write. Delta Sync is the default option which 

only syncs the changes in the rows of the tables. This option works very well in major databases. But 

small databases like Access, DBF, files (binary or text), etc. it determines the changes by loading the 

entire database and determines the changes by comparison. For major databases, the database is not 

loaded, but SOALIB uses the database specific functions or features to find the changed rows. 

Validation option validates the mapper against the database each time sync operation starts. 

Validation increases the time to sync and is an over to the sync periodic sync is chosen. If period sync

is chosen, it is not necessary to validate the mapper against the database at each sync period due to 

the fact that it already validated the mapper in the previous successful sync. The better option is to 

make sure that the sync works and then turn off validation by clearing the Validation check box. 



Then the validation stop will be skipped. However, if periodic sync is not being used, it is always 

recommended to validate. 

Advanced Sync Options

Advanced sync options are Fetcher Chunk Size, Delta Fetch Size and Mixer. Fetcher Chunk 

Size is a delta engine parameter which tell it to fetch the number of rows to fetch in a batch. The 

higher the chunk size, the less number of fetches needed to be done in order to finish sync. However, 

high fetch size would need more memory and may be slower for some databases. The optimal value 

is obtained by trial and error. The default value of 1000 usually works very well for most databases. 

For Enterprise Oracle with large memory, a value of 5000 have been tested to be quite good.

Delta Fetch Size is another delta engine parameter used during batch writing to the target 

database. Increasing the value will cause large batch of rows to be written into the database. 

However, increasing the value have the same drawback as the Fetcher Chunk Size option. The 

optimal value is again a trial and error issue. The default value of 1000 works well with most 

databases.

The Mixer option is described in detail in the Data Mixer section above.

Sync Filter

Sync filter is an advanced form of pre-sync filtering offered in SOALIB. It allows the users to sync 

only those rows in a table for which a particular user value entered for each column in each table 

match. First open the Sync Filter dialog by clicking on the Filter button next to the Sync button. This 

opens up a filter dialog with three columns. The first column displays table names in the source 

database, the second column displays the columns under each table (in combo boxes) and the third 

field allows the user to enter values. To apply filtering on a particular row, the user selects the table 

by selecting the associated check box and then choose the column of that table for which the filtering

will be needed and then entering the value to look for. The filtering will be applied table by table at 

the time of sync. So, if there are multiple tables used the filters will be applied during the sync of that 

particular table. If the mapper does not contain that table, then the filtering for that particular table 

will be ignored, while others that are in the mapper will still apply. 

SELECT statements could also be inserted as values. For example, if the sync is required only 

for the state of Massachusetts in the Schools table (see example below), we put 'MA' in the value field 

and then a SELECT statement in the State field. By properly choosing values for each table and using 

SELECT statements, one can design a filter that sync only a portion of a large database that interest 

the user. For example, in the source and target database relationship, if the source is that master 

database that contain all the information and the target only requires portion of the data of the 

source, the data of interest, filtering allows to choose those data to be used for syncing instead of 

syncing the entire database. To apply Sync filtering, the mapper and the creator of the sync profile 



must know their own database design and the format of their data so that appropriate filtering could 

be applied. Filters, once created, must be applied by pressing the Apply button and then saved into 

the profile by using the Save button. 

Sync Profile

Sync profile (the bottom portion of the sync dialog) provide and option to save the sync 

settings under a profile name. Choosing a good name to identify the sync settings is very helpful. To 

save the sync profile, hit Save. To delete it, hit Delete. To select a sync profile, simply select the item 

from the combo box. If a sync profile is chosen in which one of the source or target key (or both 

keys) is (are) not found, it will display a warning saying that the key was not found. This indicate that

the database with that key is not loaded into SOASYNC. If the key exists, load the database from that 

key into SOASYNC to fix the error.



Syncing

With all the steps completed above, Syncing can be started by simply pressing the Begin Sync 

button. As soon as sync starts, it will display a tab with title Sync [instance], where instance is the 

name of the instance of the sync. First SOALIB will attempt to connect to the source database. If there 

is a tunnel attached with the connection key, it will have some activity as can be viewed in the 

tunnel.log or Tunnel View. After successful connection to the source database, attempt will be made 

to connect to the target database. Again there will be another tunnel activity if the target connection 

has tunnel security attachment. After connection to both databases, there will be a Validation step if 

the Validation option is chosen in the sync options. The actual sync will begin according to the order 

of the mapper. If the mapper  order (the sync order) was user defined, each table will be synced in 

the forward direction first then in reverse direction. All the tables in the mapping will be synced in 

this form until the sync is done. 

If a schedule was selected at a certain date or time (with or without delay), the sync window 

will not have any useful message until the sync actually starts at the schedule. If the sync was 

scheduled every day or at hours interval, the sync window may be closed and then the sync status 

could be check later. To do that, select the instance name from the Instances list box and double click

it or hit the Show Output button. This will open the output windows in SOASYNC's main work view.



Periodic Sync

Periodic sync is one of the powerful feature of SOALIB. Once the sync is scheduled to run 

periodically, it will never stop until the user destroys the instance. Even SOALIB server were restarted

by the host or even if the host reboots and SOALIB server restarts, periodic sync will automatically 

resume. Periodic sync preempts an overlapping sync. For example, if a sync was scheduled every 5 

minute and one of the sync take more than 5 minute, SOALIB will blocks (prevents) all successive 

schedules until the present sync is complete. When the sync is complete, the block is removed. The 

missing sync schedules were never rescheduled, they are simply ignored.

Increasing Sync Speed

There are several ways to increase the sync speed. If one large mapper which maps all the 

tables into the database is used, this is called the sequential approach. Sequential sync will always be 

slower than the parallel approach (discussed later) due to the fact that syncs of other tables does not 

happen until the previous table sync is done. To make sync in parallel, multiple instances with 

multiple schedule is required. The database designer should split the mapper into independent 

mapper and dependent mappers. An independent mapper have tables which does not change very 

often and does not rely on other tables or rely on tables within that independent mapper. The 



dependent mapper(s) are mapping which rely on dependent mapping. Because the independent 

mapping change slowly, the sync period should be longer (for example, hourly or daily) vs. the 

dependent mapper which could be synced minutely. By splitting the entire (database should be large 

enough to justify sync splitting) into multiple mapper and syncing each at different sync schedule 

and intervals will significantly increase the speed of sync.

Another point to note is that syncing via a Tunnel is always slower then connecting to the 

database directly. Direct connection to database obviously require and open port on the internet for 

SOALIB to connect to.

Batch Sync

Batch sync allows multiple sync profiles to be batched for syncing sequentially one after 

another. Batches could also be scheduled like syncs. Similar to sync dialog, Batch sync dialog allows 

the user to choose any one of the schedules for sync, allow instance name entry, batch name 

selection. To create batch, the Batch Management tab will be used. If there were no previously 

created batch, then the Batch Name combo box will appear blank. Once a batch is create, it will 

appear in the Batch Name combo box.



Creating a Batch

Creating a batch requires sync profiles to be created first. Go to the Batch Management tab in

the batch dialog. In the Profiles area on the left of the dialog tab you will see a list of sync profiles 

which you created. You may expand it for details by clicking on the profile.

First create a batch by typing a batch name. A batch name should be descriptive enough to 

tell the user what it does. Create the batch by hitting Create New Batch button. This will display an 

empty batch in the Batches list box. To include a profile in the batch, drag that profile into the batch 

name which you created in the list box. You can add multiple profiles into the batch. You can also 

reorder the batches by dragging up or down a batch (in the Batches list). Ordering the batches allows

the user to prioritize the sync. The profile that appear at the top will be sync first and then successive 

sync will proceed. If an intermediate sync fails, sync will continue to the next profile in the batch.

A batch can be removed by right clicking on the batch and clicking Remove menu option. 

Similarly, a sync profile included in a batch can be removed by right clicking and hitting Remove. 

Hit the Save button to save the newly created batch. In our example at the right there are two

profiles created one syncing from source to the target and the other syncing from the target to the 

source. After the sync is complete, the source and the target will be in sync. Also note that the reason 

source (edu1) to target (edu2) is synced first was due to the order in the batch.

Syncing the Batch

In the Sync tab, choose a schedule (if necessary) and check the Use Schedule check box to 

apply the schedule in the sync. If the sync is one time, then do not check the schedule check box. 

Enter an identifiable instance name. Select the batch name from the combo box. Hit the Sync button. 

This will open the Batch sync output tab window in SOASYNC's may view. Sync will progress from 

the first sync profile and then to the successive sync profiles. The output contains information about 

each individual sync within the batch. Presently, the only way to jump into each sync profile is to 

browse through the log. Search the text “[BATCH]” to jump into each entry of the batch (i.e., each 

sync profile. 



Data Mixer

Data mixing is a feature in SOASYNC which enables data to be mixed, combined and merged

with other data at sync time. To create a mixer, a mapper must first be created. See section Creating 

Mapper to create mapper. Click Soasync  Mixer...→  to open the Mixer View.



Initially, there are no mixers, so the list view on the left with section title “Mixers Content” 

will be empty. On the right section with title “Mixer Details” under the Mapper tab contain a list of 

mapper names under which are found individual mapper per table. Mixers are applied on individual

table per map. Expand a mapper by double clicking onto it. From the expansion, select a mapper. 

The details of the mapping between the source and the target table is shown on the right side of the 

table. Each map could be expanded to find out the data type and data characteristics (like Primary 

Key, Null/Not Null, etc.) To mix data, double click on any of the mapped row (on the right side), 

which will add a default mapping into the VALUES tab in the bottom code view. 

Choose any of the functions to convert it into apply. However, more functions are available when 

coded manually. For example, for Name and State columns, we have used the _lower() and 

_upper() functions, but we used _date() function, which gets the current date from the server. 

For Population, we set it to a numeric value directly.



The Mixer has two types of variables: source variables start with a single dollar ($) sign. The 

target variables starts with two dollar ($$) signs. Any thing that is assigned to the target variable will 

go to the target database. To see the generated code, click on the CODE tab. The following code is 

generated:

$$Name = (String)_translate(_lower($Name), "VARCHAR");

$$Established = _date();
$$State = (String)_translate(_upper($State), "CHAR");

$$Population = 1000000;

Click on the Save button to save the mixer. If there were no error, the mixer will be saved and appear

on the left view. To test the mixer, click on the TEST tab. Generate random data or enter your own 

data and press Run. The output will be displayed on the right. 

If the output is satisfactory, the mixer may be applied at sync time by going to the Advanced Sync 

Options dialog and select the mixer which has the same name as the mapper. 

Mixer Language

The programming language used by the mixer is a subset of the Java programming language.

Therefore, instead of using _upper() or _lower() methods in our example above, one could have also 

used $Name.toLowerCase() and $State.toUpperCase() respectively. But, if used this way, it 

would fail if either $Name or $State were null. The language allows users to create their own 

classes within the mixer code which they could use during mixing. For example, see the code below.

class LOOKUP {

public static final int population(String state) {
if (state.equalsIgnoreCase("ma")) {

return 5000000;
} else if (state.equalsIgnoreCase("ny")) {

return 10000000;
} else {

return 0;
}

}
};

$$Name = (String)_translate(_lower($Name), "VARCHAR");

$$Established = _date();
$$State = (String)_translate(_upper($State), "CHAR");

$$Population = LOOKUP.population($State);



The class allows the user to create a lookup table in pure java. 

Restrictions

The Mixer language have certain restrictions. The language supports Java language but restricts all 

of following:

1. No external classes could be used using fully qualified class names. For example, one may not use 

java.util.Properties in the code. This will throw compilation error for using fully qualified 

class names.

2. Some classes which does not require fully qualification are restricted. These are: "System", 
"Thread", "ClassLoader", "Compiler", "InheritableThreadLocal", "Package", 

"Process", "Runtime", "RuntimePermission", "SecurityManager", "ThreadGroup", 

"ThreadLocal"

3. Keywords: interface, extends, super, synchronized, abstract, assert, throw, native, 

transient, volatile, implements cannot be used.

4. Full Math libraries are available, including BigDecimal and BigInteger classes.

5. The following classes from thejava.util package are available: Random, List, Map, 

ArrayList, Hashtable, HashMap, Vector, Calendar, Collection, Collections, 

Enumeration, Iterator, LinkedList, Stack, TimeZone, Scanner, Set, 

SortedMap, SortedSet, The user have to use the class name only without the java.util 

package prefix. For example, Vector v = new Vector();

6. The following classes from the java.sql package are available: Types, Date, Time, Timestamp,

Blob, Clob, NClob, Array. These classes should be used without the package name prefix.

Datatypes

The datatype of the column is listed in the second table on the right. The code must translate to the 

target datatype using the _translate() function. The _translate() method has the following prototype:

Object _translate(Object input, String targetType);

This method translate the input object, if possible, to the target data type, where the target data type 

is the datatype listed in the Target Table column. If datatype is not properly converted, there will be 

compilation error.

Functions

In addition to many of the Java functions which could be used, the following functions are more 

convenient.



_date() : Returns the current Date as java.sql.Date

_date(Object o): Converts the object in the argument into java.sql.Date, if possible. Example:

_date(“2013-03-21”)

_date(Object o, String deltaDate): Adds or subtracts the deltaDate from the date obtained 

by the object. Example: _date(“2013-03-21”, “-1-1-2”) will return a date in java.sql.Date

indicating a date 2012-02-19. _date(“2013-03-21”, “+2-3-5”) will return a date in 

java.sql.Date indicating a date 2015-05-24.

_decimal(Object o): Converts any argument into java.sql.BigDecimal. If conversion not 

possible, then returns 0 in BigDecimal.

_float(Object o): Converts any argument into float. If conversion not possible, then returns 0 as 

float.

_double(Object o): Converts any argument into double. If conversion not possible, then returns 

0.0 as double.

_int(Object o): Converts any argument into int. If conversion not possible, then returns 0 as int.

_long(Object o): Converts any argument into long. If conversion not possible, then returns 0 as 

long.

_short(Object o): Converts any argument into short. If conversion not possible, then returns 0 as

short.

_string(Object o): Converts any argument into String. The method calls the toString() 

method of the object, if the object is not null. If null, returns null.

_number(Object o): Converts any argument into BigInteger. If conversion not possible, then 

returns 0 as BigInteger.

_lower(Object o): Converts any argument into lower case characters. If conversion not possible, 

returns the argument itself.

_upper(Object o): Converts any argument into upper case characters. If conversion not possible, 

returns the argument itself.

_time(): Gets the current time as java.sql.Time.

_time(Object o): Converts, if possible, the argument into java.sql.Time. 

_timestamp(): Gets the current timestamp as java.sql.Timestamp.

_timestamp(Object o): Converts, if possible, the argument into java.sql.Timestamp. 



_title(Object o): Converts, if possible, into title with each word starting with a capital. Example:

_title(“soalib, inc”) returns “Soalib, Inc”.

_trim(Object o): Returns a trimmed object, if possible, as String.

_log(Object o [, boolean timestamp]): Logs the object by calling it's toString() method.

The second parameter is optional. If set to true, it will prefix the log with a timestamp. Otherwise no 

timestamp is used. The output of the log is stored in a log file under .logs/mixer/{mapper-

name}.log file. This method is very useful for debugging purposes. The code sample shown below 

converts data into XML format, which could be viewed using the SOASYNC's File Explorer.

$$Name = _trim(_upper($Name));

$$Established = $Established;
$$State = _lower(_trim($State));

$$Population = $Population;

/* 
 * Create XML and save in the log file.

 * View this log file using SOASYNC's File Explorer in Soasync menu.
 * The file could be found in the .logs/mixer directory.

 */
StringBuilder xml = new StringBuilder();

xml.append("<states>\n\t<name>")
.append($$Name)

.append("</name>\n\t<established>")

.append($$Established)

.append("</established>\n\t<state>")

.append($$State)

.append("</state>\n\t<population>")

.append($$Population)

.append("</population>\n</states>");

_log(xml);

Mixer Usage

Mixer is a very powerful feature of SOASYNC. Because the mixer language is Java, the code section is

compiled and loaded into memory at sync time, and therefore there is very little overhead on 

execution speed. A developer may use mixer to migrate from one database to the other, perform 

runtime calculation and apply business logic, log data from database, generate text based files for 

viewing in text editors or spreadsheet, etc. 

Connection Sharing

In a multi-user environment, when a single database connection is to be shared with 

multiple SOALIB users, connection sharing may be used. The owner of the connection should first 

allow the connection as sharable. Select the connection in the connection view and open the connect 

dialog. Select the Share tab.



The Share tab will be initially blank. Add SOALIB usernames to whom you would like access 

to the share. The usernames must exist, but, for security reasons, at the time of share creation, the 

usernames will not be verified. It is the responsibility of the share creator to make sure that the users 

exists. Hit the Save button to save the share. This will generate UUID and display a link for the share. 

The default expiration is typically 1 year, but the user may choose any expiration date. The most 

important part is the share link, which is of the following format:

connect://key@owner#password

key - connection key name

owner - owner of the key (i.e., the creator of the key)

password - generated password

An example of the share link is:

connect://attendance.mysql.soalib.com@admin@soalib.com#JQembi25

The owner of the key is not allowed to create a link to its own key. In the above, the user 

admin@soalib.com shared the key named attendance.mysql.soalib.com to SOALIB users 

hossain2390@gmail.com and carehome22@yahoo.com and only these two users may create a link 

to the share. To create a link one of these user must do the following.

Log into SOALIB from SOASYNC. Open the Connect dialog from Soasync menu and hit Add 

mailto:carehome22@yahoo.com
mailto:hossain2390@gmail.com
mailto:admin@soalib.com


Link button. Enter the link with the proper key and owner information which is shared. Hit the Add 

Link button. You will notice that the attendance key is added in the Connections View. You can load 

databases, do sync and do just about any operation using this connection link. The only difference is 

that this connection is not editable. 

Go to Connection Dialog again and notice that the tabs are disabled. The only option 

available is to delete the link.

To delete the link, simply hit the Delete Link button in the connect dialog.

Advantages of Connection Sharing

Sharing a connection is a powerful and a very useful feature of SOALIB. The following are some of 

the advantages of using a link:

1. A database administrator may create a link for use by others in an organization so that original 

connection may not be deleted and can only be under control of the administrator. If the database 

name, password, or other settings change, the linked user does not have to make any change.

2. Links are extremely important for collaboration, data sharing and temporary database access.

3. In distributed applications where many users access the same database, shares are very important 

A shared database connection creates a link for each allowed users, but it is not necessary for each of 

these users to create the link in SOASYNC. Links can be used as a key by itself. That is the following 

connect URI in our example,

connect://attendance.mysql.soalib.com@admin@soalib.com#JQembi25

may itself act as the key. Therefore, a mobile application written for Android, iPhone, Blackberry may

connect to database simply by using the above connect URI. This URI can be saved in encrypted form 

so that only the application may use the link. When the user is logged into SOASYNC, they will not 

see any key based on the connect URI. 



File Explorer

File Explorer can be opened by clicking Soasync  File → Explorer... menu item. This opens up a

file explorer view in the Soasync's main work view. File Explorer is used to backup local PC files into 

the server and using SOALIB as an external storage device. Open Windows Explorer (for Windows), 

File Managers in Linux, Finder (in Mac OS X) and drag the files into the File Explorer. When you 

drop, the files get copied to the server from local hard drive. There is a limit on total space in SOALIB 

online (See http://soalib.com for details). To retrieve the files, drag the files from the File Explorer into

your directory (or Desktop, etc.). The selected files are copied to the selected location. You can create 

directories in File Explorer and also double click to open the file with known extension. 

File Explorer is a useful place to store files that is to be shared using mobile devices. Soasync 

Mobile can read the files which was saved through the PC and therefore sharing the files across PCs, 

mobile devices and other platforms.

Log History Retrieval

As discussed in the Sync section above, to view the log of a running sync, one have to double 

click on the instance to view the log. However, all the log files are actually stored in the .logs 

directory of the SOALIB user's account. Expand the .logs folder all the way and you will find the 

log history of syncs and batch sync. This log is available even when the instance is destroyed. Simply 

double click on the log file to open the logs. The log file names for syncs would be the mapper name 

with .log extension. For batches, it would be batch name with .log extension. 

http://soalib.com/


Query Editor

Query Editor is launched when the button ( ) in the Databases view is pressed. Write an 

SQL query in the top portion of the query editor window and press the execute button to execute the 

command. The output of the query is displayed in the table below. The fetch size is the number of 

rows to be displayed when the number of rows in the database is large. The default is 100 rows. To 

move between successive fetches (paging) use the left ( ) and right ( ) buttons. A Query is open 

only for a limited time for security purposes. After 120 seconds, the query connection will close (the 

window will remain open), so no further query will be executed. To execute a query again, close the 

Query window and start another query session.



Demo and Testing

SOASYNC comes with sample tables and Test API and GUI. Open the Test GUI by selecting from

menu Account  Test→  item. The first step before any test could be done is to setup the tables. If you

are working with an empty database, then this step will create the tables. If the tables are already

there, this step will drop and then recreate the tables.

IMPORTANT:  When testing,  do not  use  the  production database.  Create  a  separate  database  for

testing or demo only.

To do the tests, you must have a connection key with which you can connect to the database. Start

the tunnel if needed for connection. If there are no tables in the database, the Databases view will

only show the database connection key with database name. It cannot be expanded.

Setup

In the Setup tab, there are two group of setup: Tests Setup and Table Setup. You must first use Tests

Setup, if there are no tables in the database. In Tests Setup, choose a source and target connection key

from the combo boxes. Then choose the options before hitting the Setup button. It is recommended to

choose all the option if using for the first time. Once you get familiar, you may choose individual

options.



Reload Data: Fill created tables with sample data. If this is the first time, it is recommended to check

this option.

Generate mappers:  Generate sample mappers  for  testing.  If  this  is  the first  time,  also check this

option.  If  this  is  not  the  first  time,  then  this  operation  will  overwrite  the  mappers  which  was

generated by this tester before. This operation will not delete any mappers that was not created by

the tester. 

Generate schedule: Generate sample schedules for testing. If this is the first time, also check this

option.  If  this  is  not  the  first  time,  then  this  operation  will  overwrite  the  schedules  which  was

generated by this tester before. This operation will not delete any schedules that was not created by

the tester. 

Generate batch: Generate sample batches for testing. Check this option if you like to learn about

batch sync.

Generate mixer:  Generate sample mixers for testing. Check this option if you like to learn about

runtime mixing during sync.

Generate profile:  Generate sample profiles  for  testing.  Check this  option to  use the sample sync



profiles.

Clear sync cache: Clear all the cache from previous sync.

Click on the Setup button. This will  create source and target tables.  Refresh the database in the

database view to see the generated tables.

The Table Setup group is used mainly to recreated the generated tables for the given connection.  The

Population option have several options:

Do Not Populate Creates test tables if not exists, otherwise, does nothing.

Populate with SOURCE Data Populates the source tables with SOURCE data, but does not populate the

target tables.

Populate with TARGET Data Populates the target tables with TARGET data, but does not populate the

source tables.

Drop Test Tables Drop the test tables.

The Output tab displays the progress of the setup process.
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